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SYSTEME DE GESTION DE LA TEMPORISATION POUR PASSAGE A NIVEAU V1.3 
Le 23/08/2021 

Ce montage élabore un signal de sortie, pour gérer la fermeture et l'ouverture d'un passage à niveau. 

A base de PIC 16F690, il détermine automatiquement le moment de fermer les barrières à l'arrivée d'un train, et 

d'ouvrir les barrières juste après le passage du dernier wagon au droit du PN. 

Le programme en version V1.1 remet les potentiomètres dans le bon sens, en accord avec le dessin du circuit 

imprimé, mis lui aussi à jour. 

Le programme en version V1.2a des temporisations adaptées à un réseau de taille normale. 

La documentation en V1.3, modifications pour éviter les parasites, suite à l'utilisation sur plusieurs réseaux. 

 

Ce montage fonctionne quelque soit le sens de parcours du train. 

 
 
Un circuit imprimé gère deux PN simple voie, ou un PN double voies. 

Il complète aussi le montage de commande de PN à servomoteurs, présenté ici : http://www.la-

tour.info/uts/uts_page13.html#pn_srv, mais il peut être utilisé de manière autonome. En sortie, on a un signal fixe de 

commande, ou la possibilité de faire clignoter directement des leds rouges, pour un PN sans barrières. 

 

 

Il faut installer trois capteurs [1A], [2A] et [3A] sur la voie, qui vont permettent de savoir où se situe le train. 

Le programme source en assembleur du PIC 16F690 et le fichier .hex sont fournis. Dans l'annexe en fin de ce 

document, on trouve toutes les explications pour programmer le PIC 16F690 de Microchip. 

 

Pour réaliser le circuit imprimé, le fichier "Systeme de temporisation PN - Typon - CADCAM.ZIP" est fourni. Il permet 
de faire réaliser directement le circuit imprimé sur ce site : https://jlcpcb.com/ 

 

Ces montages, ainsi que les barrières infrarouges sont décrits sur le site: http://www.la-tour.info/uts/uts_index.html 

Des discussions sont les bienvenues sur le forum RMF, section : Electronique analogique, électricité, alimentation. 

Le montage par détection infrarouge performant par réflexion, décrit sur ce même site "UTS2000", est conseillé pour 
détecter les trains, même sur un réseau existant.  
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INSTALLATION 

Le 23/08/2021, la documentation passe en V1.3, avec des modifications pour éviter les parasites, suite à l'utilisation 

sur plusieurs réseaux. 

Ces condensateurs sont maintenant prévus sur le circuit imprimé, en version du 16/08/2021. 

Si ce montage est sensible aux parasites générés par le passage d'une locomotive et que le PN se ferme 

complètement de façon intempestive, il faut ajouter un condensateur de 100 nF entre les entrées et la masse. C'est 

surtout valable pour les entrées où le montage détecteur est à plus de deux mètres de ce module. Exemple du 

condensateur gris sur l'entrée "IN1A" : 

 

 

Ce montage s'interface directement avec le montage de commande barrières de PN à servomoteur déjà présenté sur 

le site UTS2000.Il complète le montage de commande de PN à servomoteurs, présenté ici : http://www.la-

tour.info/uts/uts_page13.html#pn_srv 

Le branchement entre ces deux modules :  
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Ce montage peut être aussi utilisé de manière autonome, pour faire clignoter des leds d'un passage à niveau sans 

barrières. 

 

 

Branchement des entrées de détection du passage des trains. 

 

On peut utiliser des détections diverses, par contact, relais reed, barrières infrarouge… 

 

 

 

Le plus facile est d'utiliser le montage universel, ultime et performant de détection par réflexion, proposé ici : 

http://www.la-tour.info/uts/uts_page13.html#dec_12f675 

 

Il est facilement intégrable sur un réseau existant. 

Il détecte un train sans interruption, même si l'attelage reste positionné au droit du capteur. 
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PRINCIPE DE FONCTIONNEMENT 

A la mise sous tension, la led témoin située sur le circuit imprimé s'allumé pendant une seconde, pour confirmer la 

mise sous tension. Ensuite, le montage est en attente d'un événement. 

 

 

1 / Si le train passe devant le capteur périphérique [1] ou[3]. Le montage active le signal de sortie, le PN va se 

fermer. 

Une fois le dernier wagon passé devant ce capteur [1] ou [3], le train a 20 secondes pour passer devant le capteur 

central [2], sinon passé ce délai, le signal de sortie sera désactivé, et le PN s'ouvrira. 

Si le train s'arrête longtemps en cours de trajet, ou fait marche arrière ou si on retire le train du réseau, il faut 

bien remettre à un moment à zéro, le montage, pour qu'il soit prêt pour le prochain passage. 

 

2 / Le convoi passe ensuite devant le capteur central [2]. Une fois le dernier wagon passé devant le capteur central 

[2], quand plus rien ne passe pendant 1seconde, le signal de sortie passera inactif, le PN s'ouvrira. C'est donc bien le 

passage du dernier wagon, qui déclenchera l'ouverture du PN. 

Le train peut rester indéfiniment devant le capteur [2], le PN restera fermé. Pour fiabiliser ce capteur [2], si 

c'est une barrière infrarouge, la placer de préférence en biais pour ne pas être en défaut entre deux wagons à 

l'arrêt. On peut aussi placer un capteur de chaque coté du PN, reliés ensemble sur la même entrée IN_2 du 

montage. 

 

3 / Quand le train a fini de passer devant le capteur [2], il a 20secondes pour passer devant le capteur de sortie [1] 

ou [3], sinon le montage se remettra tout seul en attente d'événement. 

Le train passe enfin devant le capteur de sortie [1] ou [3]. Une fois le dernier wagon passé, quand plus rien ne passe 

devant ce capteur pendant une durée de 2 secondes, montage se remet en attente d'événement. 

Ceci permet de faire la différence entre le train qui sort devant le capteur de sortie [1] ou [3], et un nouveau 

train qui arriverait en sens inverse sur la même voie. 

Cela permet aussi la gestion des trains longs, qui peuvent se trouver devant plusieurs capteurs à la fois (2 ou 3 

capteurs à la fois), et deux trains courts qui se suivent de près, le second train entrant sur la zone d'entrée, 

alors que le premier n'a pas encore quitté la zone de sortie. 

 

A la mise sous tension, la led témoin située sur le circuit imprimé s'allume pendant une seconde, pour vérifier la mise 

sous tension. 

Elle s'allume de manière fixe quand le PN doit être fermé. 

Elle clignote à l'ouverture du PN, en attente de la libération de la zone de sortie. 

Elle s'éteint quand le montage est de nouveau en attente d'événement. 
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UTILISATION 

Le montage est alimenté en 12 volts (8 à 15 volts) et consomme moins de 10 mA. Il est protégé contre les inversions 

de polarité. 

Quand un train est détecté par un capteur, l'entrée du montage doit être mise à la masse (0 volt). Le signal d'entrée, 

peut provenir d'une sortie à collecteur ouvert ou d'un relais. Il peut être compris entre 0 et 5 volts.  (12 volts 

maximum possible, mais à éviter). 

Quand le PN doit se fermer, la sortie du montage passe à 0 volt (Sortie collecteur ouvert). 100 mA max sous 24 volts 

max. Si l'on commande un relais, il est indispensable de placer une diode anti-retour aux bornes du relais. 

 

Réglage des potentiomètres : 

Dans la majorité des utilisations, par défaut, mettre les potentiomètres : 

"DELAI_OUVERTURE" au minimum (Dans le sens anti-horaire �), pour avoir un délai court  de 0,3 secondes. 

"DELAI_LIBERATION" à mi-course, pour avoir un délai de 20 secondes. 

"TEMPO" tous les quatre à mi-course,pour avoir un délai de 20 secondes. 

 

• DELAI_OUVERTURE, réglable de 0,3 à 5 secondes. 

Délai entre le moment où le dernier wagon a quitté le PN (Barrière [2]) et le moment où le montage donne 

l'ordre d'ouverture du PN. 

• DELAI_LIBERATION, réglable de 0 à 40 secondes.Si le potentiomètre est à fond (> 98 % de la course), le délai 

est forcé à 3 mn. 

Une fois que le train n'est plus sur le PN, il a ce délai pour arriver au détecteur de sortie. Pour détecter un 

nouveau train qui arriverait du côté ou le train précédent est sorti, s'il ne se passe plus rien pendant 20 

secondes après l'ouverture des barrières, on considère que le train a disparu (Par exemple, train retiré 

manuellement du réseau). 

• TEMPO_IN1A, IN3A, IN1B, IN3B, réglage de 0 à 40 secondes. Si le potentiomètre est à fond (> 98 % de la 

course), le délai est forcé à 3 mn. Par défaut le réglage central donne 20 secondes. 

Le train a ce délai pour passer d'un détecteur d'entrée de zone au détecteur du PN. Si un train rentre sur la 

zone d'arrivé, et si il ne se passe plus rien pendant 20 secondes, on remet le montage en attente. (Par 

exemple, train retiré manuellement du réseau ou le train a fait marche arrière). Quatre réglages 

indépendants pour chaque capteurIN1A, IN3A, IN1B, IN3B. 

 

Les délais TEMP_INxx peuvent être placés au maximum (3 mn) si le train doit stationner un moment devant le PN, 

après avoir franchi le capteur [1]. Cela peut arriver si il y a une gare ou un signal au rouge avant le PN. 
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LES DIFFÉRENTES CONFIGURATIONS DU MONTAGE 

On peut configurer ce montage pour avoir les entrées 1A, 2A et 3A activant la sortie OUT_A, et de façon entièrement 

indépendantes les entrées 1B, 2B et 3B activant la sortie OUT_B. Le montage gère alors indépendamment deux PN 

simple voie. 

 

On peut aussi configurer ce montage pour gérer un PN double voies. Dans ce cas, les entrées 1A, 2A, 3A, 1B, 2B et 3B 

activent les sorties OUT_A et OUT_B simultanément. 

 

Dans le cas d'un PN double voie, si l'on configure les sorties pour faire clignoter les leds, les sorties OUT_A et OUT_B 

seront alors alternées. 

 

Dans le cas d'un montage autonome, on peut configurer les sorties pour qu'elles clignotent, pour alimenter 

directement des diodes leds, et choisir entre un clignotement franc ou progressif. 

 

La position des quatre mini-interrupteurs qui donnent le mode de fonctionnement n'est lue qu'une seule fois, à la 

mise sous tension du montage. 

 

 

1 / Mode normal avec 3 capteurs, pour 2 PN indépendants,dans les deux sens de circulation. 

Le montage gère de manière totalement indépendante,deux passages à niveaux distincts. 

Les sorties OUT_A et OUT_B sont indépendantes. 

Les modesde sortie fixe ou clignotante sont communs au deux PN. 

Les délais "DELAI_OUVERTURE" et "DELAI_LIBERATION" sont communs au deux PN. 
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2 / Mode économique avec 2 capteurs, pour 2 PN indépendants,dans le cas de circulation toujours dans le même 

sens. 

Le montage gère de manière indépendante deux passages à niveaux. Les délais "DELAI_OUVERTURE" et 

"DELAI_LIBERATION" sont communs au deux PN. 

On n'a pas besoin d'avoir un capteur de sortie. Il faut simplement que le capteur [1X] soit en entrée, et dans ce cas 

mettre le capteur [2X] après le PN. 

Les capteurs [3X] ne sont pas câblés. 

 

L'important, c'est que le train commence toujours par passer devant le capteur [1X]. 

On peut avoir un PN avec 3 capteurs et l'autre PN avec 2 capteurs. 

Si l'on utilise que deux capteurs par voie, et pas de capteur [3X] de sortie, mettre le potentiomètre de libération en 

début de course. Le train ne vient que dans un sens, on n'a pas besoin d'attendre la libération de la zone de sortie. 

 

 

 

3 / Mode normal pour un PN double voies. PN avec 6 capteurs, 3 capteurs sur chaque voie, pour fonctionner dans les 

deux sensde circulation. 

Les sorties OUT_A et OUT_B fonctionnent ensemble.  

Si l'on choisi le mode clignotant, les deux sorties clignotent de manière alternées. 
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4 / Mode économique avec 4 capteurs, 2 capteurs sur chaque voie,pour un PN double voies, dans le cas de 

circulation toujours dans le mêmesens.  

On peut avoir les deux voies dans le même sens de circulation, l'important, c'est que le train commence toujours par 

passer devant le capteur [1X]. 

Les capteurs [3X] ne sont pas câblés. 

 

 

Si l'on utilise que deux capteurs par voie, et pas de capteur [3X] de sortie, mettre le potentiomètre de libération en 

début de course. Le train ne vient que dans un sens, on n'a pas besoin d'attendre la libération de la zone de sortie. 

 

 

5 / Mode radin avec 3 capteurs en tout, pour un PN double voies. On peut avoir les deux voies dans le même sens de 

circulation. Le mode de fonctionnement est dégradé, car il faut attendre qu'il n'y ait plus de convoi devant les 

capteurs, pour le PN s'ouvre. Cela peut être long avant l'ouverture des barrières. 
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CE MONTAGE FONCTIONNE DE LA MANIERE SUIVANTE. 

Avec 2 ou 3 capteurs,  ce montage fonctionne avec une seule locomotive, un train court, long ou même très long. 

Ce montage ne peut pas fonctionner dans de rares cas limites, car on ne connait pas le sens du train au passage 

devant les capteurs.  Certains cas, comme l'arrivé simultanée sur une seule voie, de deux trains de chaque côté, ne 

seront pas gérée correctement. 

 

Cas prévus : 

 

 

Le montage fonctionne aussi avec un train long, passant devant deux capteurs à la fois. 

 

 

Le montage fonctionne aussi avec un train très long, passant devant trois capteurs à la fois. 

 

 

Le montage fonctionne aussi avec deux trains se succédant. 
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CIRCUIT IMPRIMÉ ET SCHÉMA 

Les entrées : 

Toutes les entrées sont protégées. Elles sont reliées au +5 Volts via une résistance de 22 KOhms. 

Pour activer une entrée, il faut la mettre à la masse (< 1,3 Volt). Si les entrées supportent un +12 volts sans casse, 

elles sont prévues pour être reliées par un transistor (collecteur ouvert), un contact, ou un relais au 0 volt. 

 

Les sorties : 

Les sorties sont à collecteur ouvert (24 Volts / 100 mA max). 

On peut soit utiliser le signal de sortie pour commander mon montage de commande de PN à servomoteur, soit les 

utiliser pour commander directement des leds rouges devant le PN. Dans ce dernier cas, il faut ajouter des 

résistances en série avec les leds, ou couper les petites pistes de sortie et souder les résistances cms de à 1K Ωà 10K 

Ω (En vert ci-dessous). 

 

 

La led témoin sur le montage s'allume quand le PN se ferme. Ensuite, elle clignote, le temps que la zone de sortie se 

libère. 

 

Fabrication du circuit imprimé : 

Pour les composants : http://www.stquentin-radio.com/ ou https://www.tme.eu/fr/ ou https://www.ebay.fr/. 

Sur Ebay, cocher l'option [x] Monde, et choisir un paiement par Paypal en ayant activé l'option "Paiement en 
devise". 

Pour le circuit imprimé, passer par un site comme : https://jlcpcb.com/  et envoyer le fichier Gerber "Systeme de 

temporisation PN - Typon - CADCAM.ZIP". Choisir un envoi par la poste (Choisir : Shipping Method: Standard 

Special Air Mail) , et non pas avec DHL, pour avoir un tarif réduit. 

 

 

Pour fabriquer un circuit imprimé soit même: http://letransfertpellicule.free.fr/index.php/tutoriels/les-circuits-
imprimes.html 

 

Configuration du réseau avec des détections multiples. 

Si des aiguillages sont installés de part et d'autre du PN, il faut plusieursmodules de détection, commutable vers 

le module de gestion en fonction de la position des aiguillages. Voir les détails dans le document de commande 

de PN à servomoteurs, présenté ici : http://www.la-tour.info/uts/uts_page13.html#pn_srv 
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Schéma de principe : 

 

Les deux sorties OUT_A et OUT_B sont à collecteur ouvert par des transistors BC847C. 

Les entrées IN_1A à IN_3B sont protégées par des résistances de 22 K placées en série sur chaque entrée, non 
représentées sur ce schéma. 
 
Liste des composants : 

PIC = 16F690 de Microchip au format DIL. Lead Plastic Dual In-line (P) - PDIP. 

Support CI 20 pattes. 

Régulateur = 78L05 cms. 

Diodes = 2*1N5822 au format CMS DO214 ou SMA ou 1N4004 cms [M4]. 

Transistors  = 2 * NPN = BC847C ou BC846C. 

Led rouge 3 mm. 

Condensateurs = 7*100 nF cms 1206  +  220µF/16V radial +  220µF/25V radial. 

Résistances = 2,2K + 2*10K + 9*22K cms format 1206. 

Potentiomètres horizontaux = 6*47 K ou 22 K linéaire. (Attention, il existe différentestailles). 

Bloc de 4 mini-interrupteurs DIL. 

Borniers = x*2 ou 3 broches. 

Circuit imprimé. 
 
Le programme source en assembleur du PIC 16F690 et le fichier .hex sont fournis en version V1.2, au 07/07/2021.  

Le programme en version V1.2 permet une configuration des temporisations plus pratique. 

Le programme en version V1.1 inverse le sens des potentiomètres, pour être en accord avec le circuit imprimé. 

En annexe, on trouve toutes les explications pour programmer le PIC 16F690 de Microchip. 
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Sur le circuit imprimé du 16/08/2021, il y a 6 condensateurs de 100 nF, pour antiparasiter les entrées. On n'est pas 

obligé de les installer, si les câbles d'entrées 'INxx"font moins de 2 mètres de long. 
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Installation et mise en route 

Les potentiomètres définissent les délais suivant : 

 

 

Attention, pour les potentiomètres autre que l'ouverture du PN situé à gauche, si l'on est en butée on passe 

directement à 3 minutes de délai (Si > 98 % de la course). 

 

Attention, au minimum les temporisations sont très courtes et ne sont pas utilisables en pratique (sauf pour 

l'ouverture du PN). 

 

Par défaut les régler de cette façon : 

 

 

Si l'on utilise le montage universel, ultime et performant de détection par réflexion, proposé ici : http://www.la-

tour.info/uts/uts_page13.html#dec_12f675, régler le délai d'ouvertureau minimum, car la détection est très fiable et 

déjà temporisée :  

 

 

Dans ce cas, régler le potentiomètre de "DURÉE SORTIE" au minimum sur l'autre module de détection par réflexion, 

pour une ouverture rapide des barrières après le passage du dernier wagon au droit du PN. 

 

 

Si l'on utilise que deux capteurs par voie, et pas de capteur [3X] de sortie, mettre le potentiomètre de libération en 

début de course. Le train ne vient que dans un sens, on n'a pas besoin d'attendre longtemps la libération de la zone 

de sortie : 
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Exemple de branchement du système complet de passage à niveau double voie 

 

Le module de commande de passage à niveau à servomoteur, le module de gestion de PN et 6 détecteurs. 

 

 

 

Sur ces6 modules de détection par réflexion, régler le potentiomètre de "DURÉE SORTIE" au minimum. 
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Fonctionnement et délais en détail 

 

Les temporisations TEMPO_1A, TEMPO_3A, TEMPO_1B et TEMPO_3B. 

Le montage est en attente. 

Le train rentre par la zone1 ou 3  

• Le train doit arriver sur le PN avant la tempo "1X"ou "3X" réglable de 1 à 40 sec. 

• Le temps que va mettre le train à parcourir la distance avant le PN, dépend de la distance entre les 

capteurs "1X" ou "3X" et celui du centre "2X", et de sa vitesse. 

• Si le train va au moins à 40 km/h et que la distance à parcourir est de 3 mètres, il faut que la 

temporisation soir réglée à 23 secondes, ou plus.  

• En orange, le réglage par défaut à mi-course à 20 secondes, et donc la vitesse minimum en fonction de 

cette distance. 

Temps de 
parcours (sec) 

km/h 

30 40 60 80 

mètres 

1 10 8 5 4 

2 21 16 10 8 

3 31 23 16 12 

4 42 31 21 16 

5 52 39 26 20 

 

Si l'on met une temporisation trop courte, la barrière va se lever avant que le train arrive. 

Si l'on met une temporisation trop longue, en cas de détection inappropriée, le train risque de faire le tour et de 

repasser sur un capteur avant que le PN se réinitialise. Dans ce cas, le PN peut rester toujours fermé. 

Dans l'idéal, il faut une temporisation supérieure au délai entre le passage du train entre la détection entre "1/3X" et 

le PN "2X", et une temporisation inférieure entre le passage du train en sortie de la détection "1/3X" et son retour 

sur la détection "3/1X". 

 

En pratique, plutôt entre 10 et 15 secondes pour un petit réseau, et entre 15 et 20 secondes pour un grand réseau. 

Si le sens de parcours est bidirectionnel et si le PN est avant une gare, placer le capteur de sortie à l'aplomb de la 

locomotive. Mettre le délai de libération du PN au maximum (40 secondes). Si le train s'arrête moins de 40 secondes, 

puis repart le PN ne se fermera pas. Si le capteur "3A" est trop près du PN, on peut placer deux capteurs "3A" distant 

d'un mètre et relié en parallèle sur l'entrée "3A". 

Si le sens de parcours est unidirectionnel, ne pas installer le capteur "3A". 

 

La temporisation DELAI OUVERTURE des barrières. 

Le train est passé sur le détecteur "1X" ou "3X", puis sur le détecteur du PN"2X".  

Il faut mettre la durée la plus courte possible pour ouvrir le PN le plus rapidement possible après le passage du 

dernier wagon. 

Il ne faut pas que le PN s'ouvre si on à une perte de détection du train, par exemple entre deux wagons. 

Durée réglable de 0,3 à 5 secondes. 

En pratique, plutôt entre 0,3 et 1 secondes, soit le potentiomètre au minimum ou proche du minimum.A+ 



16 
 

ANNEXE 

Mode d'emploi pour programmer un PIC  Le17/01/2021 
ou comment mettre facilement un fichier de type '.hex' dans un PIC 

 

Pour fabriquer ce montage, il faut obligatoirement programmer un circuit intégré, ce qui n'est pas si difficile que 
cela. 

Comment programmer un PIC de type 16F84, 16F628, 16F690, 12F975 d'un montage récupéré sur Internet, à partir 
du fichier '.hex' ? 

Si un montage à PIC du site UTS2000 vous intéresse, mais la programmation d'un PIC vous semble compliqué, voici 
comment procéder simplement, en utilisant un PC sous Windows. Les PIC (16F84, 16F628, 16F690, 12F675…) sont 
fabriqués par Microchip. Ce fabricant propose plusieurs produits pour leurs programmations. 

 

1 / Acheter le matériel, le Pickit3 
Acheter un boitier USB Pickit3 de programmation de PIC. On en trouve sur Ebay.fr, Amazon.fr, Aliexpress.com entre 
15 et 25 euros. Ne pas oublier de prendre la version avec le support d'insertion fourni, généralement de couleur 
verte sur un circuit imprimé rouge. 

Le Pickit3 est mieux, mais nettement plus cher. Le Pickit2 est très bien, sauf qu'il ne pourra pas programmer les PIC 
très récents, mais il pourra quand même programmer tous les PIC utilisés sur le site UTS2000. J'utilise 
indifféremment les Pickit2 et Pickit3 pour mes montages. 

 

On a donc un Pickit3, un câble usb, un câble plat en nappe et un support de circuit intégré à force d'insertion nulle. 

Sur le circuit imprimé, configurer les cavaliers suivant le type de PIC utilisé, en fait suivant le nombre de pattes du PIC 
ou format du boitier (Exemple : DIP28 = Dual In Line 28 = Circuit à 28 pattes). La notice se trouve sous le circuit 
imprimé. 
   -   DIP8 = 12F675 
   -   DIP18 = 16F84,  16F88, 16F628 
   -   DIP20 = 16F690 
   -   DIP28 = 16F873 ( 
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Pour faciliter la mise en place du PIC, j'ai tracé au feutre les séparations entre les pattes 4 et 5, et 10 et 11 du 
support. Comme cela, je colle les PIC de type DIP8, DIP18 et DIP20 au trait noir. 

 
 16F690 = J1 en B 16F873 = J1 en A 

 

 
 16F628 = J1 en B 12F675 = J1 en B 

 

Relier le câble plat au Pickit3, ou le boitier directement sur le connecteur du circuit imprimé. La broche n° 1 du 
boitier est indiqué par un repère � et correspond au signal 'vpp/MCLR'. La broche n° 6 du Pickit3 n'est pas utilisée. 

Suivre la couleur du câble pour cette broche n°1 et connecter la nappe avec ce fil en face de la broche 'vpp/MCLR' du 
circuit imprimé. 

 

Sur cette photo, le fil jaune n'est pas relié coté circuit imprimé. Pour me repérer, j'ai dessiné un triangle noir � en 
face de la broche 'vpp/MCLR' du circuit imprimé. 

Ne pas encore placer de PIC sur le support. Brancher le Pickit3 sur une prise USB de l'ordinateur. 
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2 / Installer le logiciel ' Pickit3 V3.01' pour envoyer un fichier '.hex' dans un PIC 
Ce logiciel est gratuit. Sur le site de Microchip, récupérer le fichier : 

Sur le site : https://www.microchip.com/development-tools/pic-and-dspic-downloads-archive, 
dans le paragraphe 'PICkit Archives> Pickit3' situé en base de page, prendre 'Pickit3 Programmer App and 
Scripting Tool v3.10'. 

Oudirectement, 'Pickit3 Programmer App and Scripting Tool v3.10' (10 Mo) : 
http://ww1.microchip.com/downloads/en/DeviceDoc/PICkit3 Programmer Application v3.10.zip 

 

Décompresser le fichier : 'PICkit3 Programmer Application v3.10.zip', puis 'PICkit3 Programmer Application Setup 
v3.10.zip' et exécuter le fichier  d'installation 'Setup.exe'. 

 

Une fois le logiciel installé, brancher le programmateur Pickit3 sur un port usb, sans mettre de PIC dessus. Utiliser un 
câble usb de bonne qualité, de préférence court sans rallonge usb. 

Démarrer le programme : Démarrer > Microchip >Pickit3 V3.01. 

Mettre à jour le microprogramme du Pickit3.Menu : Tools > Download PICkit Operating System, choisir le fichier 
"PK3OSV020005.hex". Attendre la fin de la mise à jour du programmeur. 

Menu : Tools > Set Unit ID,  et lui donner un petit nom à votre programmateur. 

Configurer les cavaliers du circuit imprimé suivant le nombre de pattes du PIC, comme indique la notice sous le 
circuit imprimé. 

Placer un PIC sur le support, et cliquer sur le bouton [Erase] pour effacer le PIC. 

On a le message "Done" une fois cette opérations réalisée. Le PIC est alors prêt à être programmé. 

Si l'on a une erreur au moment de quitter ce programme, il faut le configurer pour qu'il se lance automatique en 
mode administrateur sous Windows 10. Dans l'explorateur de fichier, dans le répertoire 'C:\Program 
Files\Microchip\PICkit 3 v3', clic-droit sur 'PICkit3.exe' > Propriétés, Onglet 'Compatibilité' > Cocher la case : � 
Exécuter ce programme en tant qu'administrateur. 

 

 Sans PicKit de branché avec Pickit de branché après écriture du PIC 

 

 

On doit avoir 5,0 Volts dans la case de droite, au moment de la programmation, parfois cette valeur retombe à 2,5 V. 
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3 / Programmer le PIC à partir du fichier '.hex' 
Configurer les cavaliers du circuit imprimé suivant le nombre de pattes du PIC, comme indique la notice sous le 
circuit imprimé. 

Relier le câble plat au Pickit3. La broche n° 1 du boitier est indiqué par un repère � et correspond au signal 
'vpp/MCLR'. 
Brancher le programmateur Pickit3 sur un port usb. 

Soulever le levier, mettre le PIC  à la bonne place sur le support et rabaisser le levier 

Démarrer le programme : Démarrer > Microchip >Pickit3 V3.01. 
Cliquer sur les boutons [Erase] pour effacer le PIC. 

Chercher le fichier '.hex', menu : File > Import Hex, parcourir l'arborescence et sélectionner le fichier '.hex' désiré. 

Cliquer sur le bouton [Write] pour écrire dans le PIC. 
Au bout de quelques secondes, le PIC est programmé, le retirer du support. 

Il faudra à chaque fois effacer le PIC avant d'écrire dedans. On peut faire cette opération des centaines de fois. 

 

 

4 / Si l'on dispose d'un ancien Pickit2 
Le programme est alors différent. Il faudra utiliser le programme PICkit 2 v2.61 adapté au Pickit2. 

Sur le site de Microchip, récupérer les fichiers : 
Sur le site : https://www.microchip.com/development-tools/pic-and-dspic-downloads-archive,  
en bas de page dans le paragraphe 'PICkit Archives> Pickit2',  'PICkit 2 Software for Windows v2.61' + 'PICkit 2 
DeviceFirmware v2.32' (Soumis à la création d'un compte utilisateur). 

Ou directement : 
PICkit 2 Programmer Application v2.61 (4 Mo) : http://ww1.microchip.com/downloads/en/DeviceDoc/PICkit 2 
v2.61.00 Setup A.zip 

PICkit 2 Programmer Application v2.61 avec dotNet A (31 Mo) 
:http://ww1.microchip.com/downloads/en/DeviceDoc/PICkit 2 v2.61.00 Setup dotNET A.zip 

PICkit 2 Device Firmware v2.32 (1 Mo) :http://ww1.microchip.com/downloads/en/DeviceDoc/FirmwareV2-32-
00.zip 

 

Décompresser le fichier : 'PICkit 2 v2.61.00 Setup A.zip' et exécuter le fichier d'installation 'setup.exe'. 

Brancher le programmateur Pickit2 sur un port usb. 
Lancer le programme : Démarrer >Microchip>PICkit 2 v2.61. 

Si besoin, mettre à jour le microprogramme du Pickit2.Menu : Tools > Download PICkit2 Operating System, choisir le 
fichier " PK2V023200.hex". Attendre la fin de la mise à jour du programmeur. 

Menu : Tools > Calibrate VDD & Set Unit ID ... Pour calibrer si besoin le programmateur et lui donner un petit nom. 

Pour calibrer le programmateur, il faut un voltmètre numérique correct pour mesurer une tension de  5 volts avec au 
moins 2 chiffres après la virgule (Mesuré entre VDD et GDN en sortie du Pickit2). Ensuite, on peut lui donner son 
petit nom. 

Le reste ressemble à l'utilisation du Pickit3. 
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5 / Pour modifier le fichier '.hex' avec MPLAB Tools avant écriture dans le PIC 
On a récupéré un fichier source contenant le code en clair, de type '.asm'. Ce fichier contient le code assembleur en 
clair, modifiable facilement. 

Par exemple, on peut modifier ce fichier pour ajuster des temporisations, ou configurer la table des aiguillages dans 
les fichiers 'Garage_a_pic_emetteur.asm' et 'Garage_a_pic_recepteur.asm'. 

 

Ce logiciel est gratuit. Pour compiler ce fichier assembleur de type '.asm', pour les pic 8 bits, comme les 16F84, 
16F628, 16F67, 16F690, 12F675, utiliser le programme MPLAB IDE 8.92 de Microchip. 

Sur le site de Microchip, récupérer le fichier : 
Sur le site : https://www.microchip.com/development-tools/pic-and-dspic-downloads-archive,  
en milieu de page dans la partie : MPLAB IDE Archives>32-bit WindowsMPLAB IDE 8.92 (Soumis à la création d'un 

compte utilisateur). 

Ou directement : 
MPLAB IDE 8.91 (110 Mo) : http://ww1.microchip.com/downloads/en/DeviceDoc/mplab_ide_8_92.zip 

 

Décompresser le fichier : 'mplab_ide_8_92.zip' et exécuter le fichier d'installation 'Setup.exe'. 
Attendre la fin de l'installation et quitter ce programme. 

Démarrer le programme : Démarrer > Microchip >PMLAB IDE. 
Menu File > Open, choisir par exemple le fichier 'Garage_a_pic_emetteur.asm'. 

Dans la fenêtre d'édition, modifier le texte du fichier. 

Par exemple, pour le code 'Garage_a_pic_emetteur.asm', on peut modifier les nombres '19' sur les lignes suivante: 
;******************************************************************* 

; Paramètres de configuration du programme modifiable suivant le nombre de garages disponibles. 

; 

numgarageMIN EQU  0 ; Numéro affiché minimum du garage (0-98) 

numgarageMAX EQU 19 ; Numéro affiché maximum du garage (1-99) 

 

numgarageMINX EQU  0 ; Numéro du garage affiché à la première action sur action sur le bouton (+) 

numgarageMAXX EQU 19 ; Numéro du garage affiché à la première action sur action sur le bouton (-) 

On modifie ce fichier, puis on l'enregistre, menu : File > Save As… 

 

Une fois le fichier modifié, sélectionner la fenêtre d'édition du fichier 'Garage_a_pic_emetteur.asm' 

Pour produire le nouveau fichier '.hex', menu : Project >QuickbuildGarage_a_pic_emetteur.asm. 

Si il n'y a pas d'erreur dans le programme, on la le message 'BUILD SUCCEEDED'. 
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Dans le même répertoire que le '.asm', le programme vient de créer le fichier 'Garage_a_pic_emetteur.hex' 
Il ne reste plus qu'a programmer le PIC avec ce fichier. 

 

 

6 / Installer le logiciel de développement et mise au point  gratuit de Microchip 
Si nécessaire, pour modifier de façon plus conséquente ou pour créer un nouveau programme, utiliser un 
environnement de développement plus complexe, mais plus pratique. 

Il est conseillé d'utiliser un langage plus évolué comme le Basic ou le C pour écrire de nouveaux programmes. C'est 
plus facile à écrire et à maintenir, et donc utiliser MPLAB X IDE. 

Sur le site de Microchip, récupérer le fichier MPLAB® X IDE v5.10 (850 Mo) : 
https://www.microchip.com/mplab/mplab-x-ide 

Son installation et son utilisation sort du cadre de cette petite note d'introduction au PIC. Se référer alors à d'autres 
sites plus conséquents sur la programmation des PIC. 

 

A+ 

 


